testo 6321 · differential pressure transmitter
P2A software · Parameterizing, adjusting and analyzing software

Instruction manual
1 Safety and the environment

Avoiding electrical hazards

> Never use the instrument and connected probes to measure on or near live parts!

> Damaged mains cables must only be replaced by authorized personnel.

> Only have the transmitter wired and connected by authorized personnel with the voltage disconnected.

> You must always comply with the regulations applicable in your country for opening and repairing electrical equipment.

Avoiding personal injury and damage to equipment

> Installation, setting and calibration work must only be carried out by qualified and authorized personnel!

> Only open the instrument when this is expressly described in the instruction manual for installation, maintenance or repair purposes.

> Observe the permissible storage, transport and operating temperature.

> Do not store the product together with solvents. Do not use any desiccants.

> Do not use the instrument for control purposes at the same time as operating or servicing the transmitter.

> Only operate the product properly, for its intended purpose and within the parameters specified in the technical data. Do not use any force.

> Carry out only the maintenance and repair work on this instrument that is described in the documentation. Follow the prescribed steps exactly. Use only original spare parts from Testo.

Any additional work must only be carried out by authorized personnel. Otherwise testo will not accept any responsibility for the proper functioning of the instrument after repair and for the validity of certifications.
Protecting the environment

> At the end of its useful life, send the product to the separate collection for electric and electronic devices (observe local regulations) or return the product to Testo for disposal.

2 About this document

Use

> Please read this documentation through carefully and familiarize yourself with the product before putting it to use. Pay particular attention to the safety instructions and warning advice in order to prevent injuries and damage to the products.

> Keep this document to hand so that you can refer to it when necessary.

> Hand this documentation on to any subsequent users of the product.

| WARNING | Indicates potential serious injuries |
| CAUTION | Indicates potential minor injuries |

Symbols and writing standards

<table>
<thead>
<tr>
<th>Representation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="i" /></td>
<td>Note: Basic or further information.</td>
</tr>
<tr>
<td>1. ...</td>
<td>Action: more steps, the sequence must be followed.</td>
</tr>
<tr>
<td>2. ...</td>
<td></td>
</tr>
<tr>
<td>&gt; ...</td>
<td>Action: a step or an optional step.</td>
</tr>
<tr>
<td>- ...</td>
<td>Result of an action.</td>
</tr>
<tr>
<td>Menu</td>
<td>Elements of the program interface.</td>
</tr>
<tr>
<td>[OK]</td>
<td>Buttons of the program interface.</td>
</tr>
<tr>
<td>...</td>
<td>Functions/paths within a menu.</td>
</tr>
<tr>
<td>“...”</td>
<td>Example entries</td>
</tr>
</tbody>
</table>
3 Contents

1 Safety and the environment.................................................................3

2 About this document........................................................................4

3 Contents ............................................................................................5

4 Transmitter..........................................................................................7

  4.1. Specifications ...............................................................................7
      4.1.1. Functions and use .................................................................7
      4.1.2. Scope of delivery .................................................................7
      4.1.3. Dimensions ........................................................................8
      4.1.4. Technical data ......................................................................8

  4.2. Product description ......................................................................11
      4.2.1. At a glance ...........................................................................11
      4.2.2. Scaling .................................................................................12

  4.3. Commissioning .............................................................................13
      4.3.1. Assembling the instrument .................................................13
      4.3.1.1. Wall mounting .................................................................13
      4.3.2. Wiring the instrument .........................................................14
      4.3.2.1. 4-wire system .................................................................15
      4.3.2.2. 3-wire system .................................................................15

  4.4. Maintenance and cleaning .........................................................17
      4.4.1. Cleaning housing .................................................................17
      4.4.2. Namur fault conditions ......................................................17

5 Parameterizing, adjusting and analyzing software (P2A software)....18

  5.1. Specifications ..............................................................................18
      5.1.1. Functions and use ...............................................................18
      5.1.2. System requirements ...........................................................19
      5.1.3. Scope of delivery .................................................................19

  5.2. First steps ..................................................................................20
      5.2.1. Installing the software/driver ..............................................20
      5.2.1.1. Installing P2A software ...............................................20
      5.2.1.2. Installing USB driver ....................................................20
      5.2.1.3. P2A software upgrade ..................................................20
      5.2.2. Starting the software .........................................................20
      5.2.2.1. Starting the program .....................................................20
      5.2.2.2. Establishing a connection with the instrument ..............20
      5.2.2.3. Activating the connection with the instrument .............21
5.3. Using the software ................................................................. 21
  5.3.1. User interface ................................................................. 21
  5.3.2. Editing instrument/parameter file ....................................... 24
    5.3.2.1. Changing instrument/parameter file ............................... 24
    5.3.2.2. Creating a new instrument file .................................... 26
    5.3.2.3. Saving parameters ..................................................... 26
    5.3.2.4. Opening the parameter file ......................................... 26
    5.3.2.5. Copying and pasting parameters .................................. 27
    5.3.2.6. Deleting instrument/parameter file .............................. 27
  5.3.3. Analyzing/testing the transmitter ....................................... 27
    5.3.3.1. Analyzing/testing the instrument ................................ 28
    5.3.3.2. Carrying out factory reset ........................................ 28
    5.3.3.3. Testing analog output .............................................. 28
    5.3.3.4. Displaying min./max. values ..................................... 30
  5.3.4. Adjusting the transmitter ............................................. 31
    5.3.4.1. n-point adjustment .............................................. 31
    5.3.4.2. Adjusting the analog output ..................................... 32
  5.3.5. Transmitter history ..................................................... 33

6 Tips and assistance ................................................................. 36
  6.1. Questions and answers ................................................... 36
  6.2. Accessories and spare parts ............................................ 36
    6.2.1. Ordering options for testo 6321 transmitter (0555 6321) .... 37
4 Transmitter

4.1. Specifications

4.1.1. Functions and use

The testo 6321 transmitter is suitable for the following applications, amongst others:

- Air conditioning and ventilation technology
  - Monitoring ventilation and filtration systems
  - Monitoring fans
  - Monitoring exhaust air volumetric flow rates

4.1.2. Scope of delivery

The scope of delivery of the testo 6321 transmitter includes the following:

- Assembly accessories
- Operating instructions
- Calibration report
- CD-ROM with operating instructions (PDF) and P2A update (this can only be used in conjunction with the P2A software, which has to be ordered separately).

4.1.3. Dimensions
4.1.4. Technical data

Parameter
- Differential pressure

Accuracy\(^1\)

\(^{i}\) The specifications are only valid if the positive pressure is applied at the positive pressure connection.

- 1.2 % of measuring range, additional ±0.3 Pa intrinsic error\(^2\)
- \(T_K\) slope drift = 0.05 % of measuring range per degree Kelvin of deviation from nominal temperature 22 °C
- \(T_K\) zeroing drift = 0 % (by means of automatic zeroing)

Measuring range, resolution and overload

<table>
<thead>
<tr>
<th>Measuring range depending on version ordered</th>
<th>Resolution</th>
<th>Overload</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 100 Pa</td>
<td>0.1 Pa</td>
<td>20,000 Pa</td>
</tr>
<tr>
<td>0 to 10 hPa</td>
<td>0.01 hPa</td>
<td>200 hPa</td>
</tr>
<tr>
<td>0 to 20 hPa</td>
<td>0.01 hPa</td>
<td>200 hPa</td>
</tr>
<tr>
<td>0 to 50 hPa</td>
<td>0.01 hPa</td>
<td>750 hPa</td>
</tr>
<tr>
<td>0 to 100 hPa</td>
<td>0.1 hPa</td>
<td>750 hPa</td>
</tr>
<tr>
<td>0 to 500 hPa</td>
<td>0.1 hPa</td>
<td>2500 hPa</td>
</tr>
</tbody>
</table>

\(^1\) At 25 °C. A stabilization period of approx. 30 min must be taken into account upon commissioning the instrument.

\(^2\) Measuring uncertainty in accordance with GUM: ±1.2 % of measuring range final value ±0.3 Pa.

GUM (Guide to the Expression of Uncertainty in Measurement): ISO guideline for determining the measuring uncertainty in order to render global measurement results comparable.

The following uncertainties are used during the inquiry:
- Hysteresis
- Linearity
- Reproducibility
- Long-term stability
- Adjustment area/factory calibration
- Test location
<table>
<thead>
<tr>
<th>Measuring range depending on version ordered</th>
<th>Resolution</th>
<th>Overload</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 1000 hPa</td>
<td>1 hPa</td>
<td>2500 hPa</td>
</tr>
<tr>
<td>0 to 2000 hPa</td>
<td>1 hPa</td>
<td>2500 hPa</td>
</tr>
<tr>
<td>-100 to 100 Pa</td>
<td>0.1 Pa</td>
<td>20,000 Pa</td>
</tr>
<tr>
<td>-10 to 10 hPa</td>
<td>0.01 hPa</td>
<td>200 hPa</td>
</tr>
<tr>
<td>-20 to 20 hPa</td>
<td>0.01 hPa</td>
<td>200 hPa</td>
</tr>
<tr>
<td>-50 to 50 hPa</td>
<td>0.01 hPa</td>
<td>750 hPa</td>
</tr>
<tr>
<td>-100 to 100 hPa</td>
<td>0.1 hPa</td>
<td>750 hPa</td>
</tr>
<tr>
<td>-500 to 500 hPa</td>
<td>0.1 hPa</td>
<td>2500 hPa</td>
</tr>
<tr>
<td>-1000 to 1000 hPa</td>
<td>1 hPa</td>
<td>2500 hPa</td>
</tr>
<tr>
<td>-2000 to 2000 hPa</td>
<td>1 hPa</td>
<td>2500 hPa</td>
</tr>
</tbody>
</table>

Upon delivery and following a factory reset the readings are shown in the display in the unit that was ordered via the KMAT option Fxx, see Ordering options for testo 6321 transmitter (0555 6321) page 37.

**Meas. cycle**
- 1/sec

**Zeroing cycle**
- Set to 1 min at the factory

**Interface**
- Mini-DIN for P2A software (adjustment and parameterization software)

**Voltage supply**
- 3 or 4-wire (separate signal and supply lines): 20 to 30 V AC/DC, 300 mA power consumption

**Maximum load**
- 4-wire: 500 Ω (power output)
Maximal load
• 10 kΩ (voltage output)

Analog output
• 0 to 1 V ± 2.5 mV (4-wire) or
• 0 to 5 V ± 12.5 mV (4-wire) or
• 0 to 10 V ± 25 mV (4-wire) or
• 4 to 20 mA ± 0.05 mA (4-wire)
• $T_K = 0.05 \% K$ of measuring range per degree Kelvin of deviation from nominal temperature 22 °C

Resolution of analog output
• 12 bit

Display
• 2-line LCD (optional)

Operating temperature
• -5 to 50 °C

Storage temperature
• -20 to 60 °C
4 Transmitter

Application humidity
- 0 to 90 % RH

Housing, weight
- Plastic, approx. 160 g

Protection class
- IP 65 only if the transmitter is wired and/or sealing plugs are inserted

Directives, standards and tests

Warranty
- Duration: 2 years
- Warranty conditions: see website www.testo.com/warranty

4.2. Product description

4.2.1. At a glance

1. Display for showing reading (optional, cannot be retrofitted)
2. Service interface (mini-DIN port)
3. Wall bracket (on rear)
4. Negative pressure connection
5. Positive pressure connection
6. M 16 x 1.5 screw connection, e.g. analog output
4.2.2. Scaling

There are three types of min./max. values:

1. The measuring range: The maximum sensor performance is in this range. Measuring range, see table (below).

2. Standard scaling: The output signals are assigned to this measuring range as standard:
   - during delivery if no entries are made in the order code
   - after exchanging the unit, the measuring range recorded in the instrument is applied as standard.
   - The transmitter even retains its scaling with the voltage disconnected.

3. The maximum settings for the manual scaling
   - The maximum limits can be calculated as follows:
     \[ X = \text{difference between MIN. and MAX. value of the standard scaling} \]
     \[ (\text{Max. value of standard}) + (50 \% \text{ of } X) \]
     \[ (\text{Min. value of standard}) - (50 \% \text{ of } X) \]
   - It is thus possible to scale beyond the measuring range, e.g. for the adjustment of the scaling limits to standard values of a PLC.

With the alarm definition, however, the physical measuring range limits are decisive.

<table>
<thead>
<tr>
<th>Measuring range/standard scaling</th>
<th>Maximum scaling</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 100 Pa</td>
<td>-50 to 150</td>
</tr>
<tr>
<td>0 to 10 hPa</td>
<td>-5 to 15</td>
</tr>
<tr>
<td>0 to 20 hPa</td>
<td>-10 to 30</td>
</tr>
<tr>
<td>0 to 50 hPa</td>
<td>-25 to 75</td>
</tr>
<tr>
<td>0 to 100 hPa</td>
<td>-50 to 150</td>
</tr>
<tr>
<td>0 to 500 hPa</td>
<td>-250 to 750</td>
</tr>
<tr>
<td>0 to 1000 hPa</td>
<td>-500 to 1500</td>
</tr>
<tr>
<td>0 to 2000 hPa</td>
<td>-1000 to 3000</td>
</tr>
<tr>
<td>-100 to 100 Pa</td>
<td>-200 to 200</td>
</tr>
<tr>
<td>-10 to 10 hPa</td>
<td>-20 to 20</td>
</tr>
</tbody>
</table>
### Measuring range/standard scaling | Maximum scaling
--- | ---
-20 to 20 hPa | -30 to 30
-50 to 50 hPa | -100 to 100
-100 to 100 hPa | -200 to 200
-500 to 500 hPa | -1000 to 1000
-1000 to 1000 hPa | -2000 to 2000
-2000 to 2000 hPa | -4000 to 4000

## 4.3. Commissioning

### 4.3.1. Assembling the instrument

#### 4.3.1.1. Wall mounting

**Attaching rear panel bracket**

1. Remove locking screw (see item (4) of drawing below) and detach rear panel bracket from plastic bracket (see item (2) of drawing below).

2. Hold rear panel bracket in assembly position and mark the three drill holes.

3. Drill three holes (Ø 5 mm) and insert dowels where necessary.

4. Screw on rear panel bracket.
   
   Remember that the clamping brackets (1) must face the wall.
Fastening instrument to rear panel bracket

1. Slide plastic bracket (2) on the back of instrument onto rear panel bracket until it engages (see arrows).
2. Insert screw (4) through hole (3) and screw into rear panel bracket.

4.3.2. Wiring the instrument

**WARNING**
**Electrical voltage!**

> When routing cables, ensure that there is a space between the signal line and the interfering external lines.
> If electromagnetic interference is likely, use a shielded and/or twisted cable. Connect the shield to the earth on the side facing away from the transmitter.
> If overvoltages are likely, install overvoltage protection devices.

**WARNING**

**Electrical voltage**
**Danger of injury!**

> De-energize the mains connection before connecting the transmitter.
**CAUTION**

**Damage to electronic components!**

> The terminal strip can be removed from the circuit board in order to screw on the cable ends. After wiring, be sure to completely attach the terminal strip on the contact pins as pre-assembled.

---

**Info**

Only have the transmitter wired and connected by authorized personnel with the voltage disconnected.

---

1. Loosen and remove housing screws (1).
2. Remove upper part of housing (2) from lower part of housing (3) and place on a clean surface.
3. Wire instrument (see 3-wire system page 16, 4-wire system page 16).
4. Place upper part of housing (2) on lower part of housing (3) and tighten with housing screws (1).
5. On instruments with display: Remove protective film (4) from the display cutout of the housing cover.
4.3.2.1. 4-wire system

Voltage output (4-wire, 0 to 1 V/0 to 5 V/0 to 10 V)/voltage output (4-wire, 4 to 20 mA):
U = 20 to 30 V DC/AC

4.3.2.2. 3-wire system

All ground connections are connected to one another (= one collective ground connection).

**CAUTION**

_Destruction of the instrument in the event of incorrect polarity!_

> When connecting the voltage supply, place collective ground connection on PIN 2!
4.4. **Maintenance and cleaning**

4.4.1. **Cleaning housing**
- Only clean the housing carefully with a moist cloth.
- Do not use aggressive cleaning agents.
- Do not use any solvents.

4.4.2. **Namur fault conditions**

If the faults named in the following table occur, the analog outputs output special values that enable a general fault warning in the higher-level control system. The values correspond to the "Namur" industry standard.

<table>
<thead>
<tr>
<th>Status message in the display</th>
<th>Class</th>
<th>Display value in the display</th>
<th>Analog output</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 to 20 mA</td>
</tr>
<tr>
<td>Watchdog error</td>
<td>Error</td>
<td>Previous value stops</td>
<td>3.8 mA</td>
</tr>
<tr>
<td>Value below min. scale</td>
<td>Underrange</td>
<td>Reading</td>
<td>3.8 mA</td>
</tr>
<tr>
<td>Value above max. scale</td>
<td>Overrange</td>
<td>Reading</td>
<td>20.5 mA</td>
</tr>
<tr>
<td>Pressure too high</td>
<td>Overrange</td>
<td>ooooo ·</td>
<td>20.5 mA</td>
</tr>
</tbody>
</table>
5 Parameterizing, adjusting and analyzing software (P2A software)

5.1. Specifications

The P2A software is used for the parameterizing, adjustment and analysis of testo transmitters. The following applies:

- Generally, all newer testo transmitters (as of 2007) are supported.
- Included with every testo transmitter that is bought new is a CD that contains a free upgrade of the software, which includes the device drivers for all transmitters that can be attached at this time.
- This upgrade can be downloaded at any time via the testo homepage "www.testo.com/Download/P2A".

The software must only be bought one time, even for owners of several testo transmitters.

5.1.1. Functions and use

In the P2A software, two different file types are used: The instrument and the parameter file.

Instrument file

The parameters of a particular transmitter are stored in its so-called instrument file. Using this file, the parameters can be edited and the instrument can be tested and adjusted.

Instrument files also contain the respective histories in addition to the parameter data, i.e. "log books" are kept for the previous parameterizations, adjustments and messages (see Transmitter history page 33).

Instrument files are ".cfm" format files.

Parameter file

Parameter files are not tied to a specific individual transmitter and contain only parameter data/no history data.

If you use various instruments of the same type, you can create parameter files once (e.g. by saving the appropriate instrument file as the parameter file) and transmit these onto the other instruments.
5.1.2. System requirements

Operating system
- Windows® 2000 SP4
- Windows® XP Home/Professional
- Windows® Vista

Computer
- Pentium processor of at least 400 MHz or equivalent
- 128 MB RAM
- Graphics resolution of at least 1024 x 768
- Unused hard drive capacity of at least 15 MB
- CD-ROM drive
- USB interface
- At least Internet Explorer 5.0

Software
The P2A software must be purchased and installed separately from the transmitter. If it is a new software version, the transmitter is already supported completely. Older P2A software versions can be updated via the P2A software upgrade (cf. product CD included with the transmitter).

5.1.3. Scope of delivery

Included in the scope of delivery are:
- P2A software
- USB driver

When working with the parameterizing, adjusting and analyzing software (P2A software), previous knowledge of Windows® operating systems is assumed. The description in this instruction manual relates to Windows® XP.
5.2. **First steps**

5.2.1. **Installing the software/driver**

![Information symbol]

Administrator rights are required to install programs and drivers under Windows® 2000 SP4, XP and Vista.

5.2.1.1. **Installing P2A software**

1. Insert CD with P2A software.

   ✓ If the installation program does not start automatically:

   > Open Windows Explorer and start the file **Setup.exe** on the product CD.

2. Follow the directions of the installation wizard.

5.2.1.2. **Installing USB driver**

![Information symbol]

Before installing the USB driver, please read the separate documentation that is enclosed with the USB driver CD.

5.2.1.3. **P2A software upgrade**

1. Insert product CD (supplied with the transmitter).

2. Open Windows® Explorer and start the file **P2A upgrade.exe** on the product CD.

3. Follow the directions of the installation wizard.

5.2.2. **Starting the software**

5.2.2.1. **Starting the program**

> Select: [Start] > All Programs > Testo > P2A Software.

- The program window is opened (see User interface page 21).

5.2.2.2. **Establishing a connection with the instrument**

Multiple instruments can be attached, however only one connection is active at all times.

✓ USB driver is installed (see Installing USB driver page 20).

1. Start the P2A software.

2. Connect adapter (supplied with the P2A software) to the service interface of the instrument (see item 2, At a glance page 11).
3. Connect instrument/adapter to the PC via the USB interface.
   - The instrument file of the attached instrument is shown in the file list.

5.2.2.3. Activating the connection with the instrument

> Click on the desired instrument file.
- The selected file is marked in colour and the connection with the instrument is activated.

If a connection with the instrument is established when the program is started, the corresponding instrument file is marked automatically.

5.3. Using the software

5.3.1. User interface

1 Menu bar:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Open</td>
<td>Shows the Windows dialogue for searching and opening files.</td>
</tr>
<tr>
<td></td>
<td>Save as</td>
<td>Saves the parameters of an instrument or parameter file under a new name.</td>
</tr>
</tbody>
</table>
### Menu | Command | Explanation
--- | --- | ---
Edit | Copy | Copies the parameters of the marked instrument or parameter file in the cache.
| Paste | Pastes the parameters from the cache in the marked instrument or parameter file.
View | Toolbar | Activates/deactivates the toolbar or status bar.
| Status bar |  |  
? | Check instrument connections | Checks the connections to a connected instrument without the instrument having to be activated.
Service |  | A text file with the most important information on the computer and the software is opened via Display service data.
Information |  | Shows the version number of the P2A software.

2 Toolbar: Shows the Windows-compliant icons for editing.
3 File:

<table>
<thead>
<tr>
<th>Icon</th>
<th>File</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| ![Symbol shows a transmitter](image) | Instrument file | Instrument file
Connection to the instrument has been established.
<Type> <Serial number>.cfm
File name should not be changed. |
| ![Symbol shows a transmitter with a red minus sign in the upper left corner](image) | Instrument file | Instrument file
Connection to the instrument has not been established. |
<table>
<thead>
<tr>
<th>Icon</th>
<th>File</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon.png" alt="Icon" /></td>
<td>Parameter file</td>
<td>&lt;Type&gt; &lt;Serial number&gt; &lt;Date&gt; &lt;Time&gt;.cfp</td>
</tr>
<tr>
<td></td>
<td>File name can be changed. File name can be selected freely, but it is recommended that you retain the reference to the instrument. Parameter files are always marked red; the parameter values they contain are only forwarded to the instrument after being transmitted to the instrument file.</td>
<td></td>
</tr>
</tbody>
</table>

4 Function buttons: Dialogues on editing and testing the instrument are opened by means of the buttons.

[Change parameterization] see Changing instrument/parameter file page 24

[Test/analyze transmitter] see Chapter Analyzing/testing the transmitter page 27

[Adjusting the transmitter] see Chapter Adjusting the transmitter page 31

[Transmitter history] see Transmitter history page 33

5 File information:

<table>
<thead>
<tr>
<th>Status</th>
<th>Shown in the window</th>
</tr>
</thead>
<tbody>
<tr>
<td>An instrument file is selected</td>
<td>Type, serial number, firmware version of the instrument.</td>
</tr>
<tr>
<td>A parameter file is selected</td>
<td>Type, serial number and firmware version of instrument for which the parameter file was created.</td>
</tr>
<tr>
<td>Connection status</td>
<td>Green = connection is active Red = connection is inactive</td>
</tr>
</tbody>
</table>

6 Status bar: Shows the current status when editing via the menu bar.
5.3.2. Editing instrument/parameter file

5.3.2.1. Changing instrument/parameter file

✓ The desired instrument/parameter file is marked.

1. Click on [Change parameterization].

- The Properties of <Instrument type> <Serial number> dialogue is opened with the Change parameterization register.

If the parameters were transmitted from other parameter files into the instrument file, a message is shown with which you can transmit the new parameters to the connected instrument using [Yes].

> If the parameters should not be transmitted, click on [No].

2. Change or enter parameters in the corresponding fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit/Analog output</td>
<td>All analog outputs are parameterized in this mask.</td>
</tr>
<tr>
<td>Field</td>
<td>Explanation</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unit/analog output (graphic)</td>
<td>Unit: 0 to 1 V/5 V/10 V or 4 to 20 mA. Vertical: Current version of the analog output (cannot be changed). Horizontal: Min./max. scale end points of selected unit. The curve changes in accordance with the entered value of scale minimum and maximum.</td>
</tr>
<tr>
<td>Scale minimum/maximum</td>
<td>The endpoints of the scaling can be selected up to the stored scale minimum and maximum. In the process, scaling can take place beyond the measuring range in order to adjust the analog output to the customer system, see Scaling page 12.</td>
</tr>
<tr>
<td>Unit</td>
<td>Selection of the physical unit. When changing the unit, standard values are set for scale minimum and maximum.</td>
</tr>
<tr>
<td>Signal delay (graphic)</td>
<td>Curve changes according to the set signal delay.</td>
</tr>
<tr>
<td>Signal delay</td>
<td>Time interval in stages 1 – 15: 1 = no delay 15 = longest delay. The signal delay is added to the reaction time of the sensor. The signal delay shows averaging over the time interval of the selected stage in seconds: Example Stage 10 = average of the readings from the last 10 seconds.</td>
</tr>
</tbody>
</table>

ℹ️ The delay of the signal in relation to the change in the process is also significantly influenced by the selection of the particle filter.
5.3.2.2. Creating a new instrument file
It is possible to create an instrument file without restarting the P2A software.

✓ Transmitter must be connected.

1. Click on File > New connection in the menu bar.
   - Connection to the transmitter is established.

5.3.2.3. Saving parameters
Parameters can be saved in new parameter files.

1. Mark instrument/parameter file.
2. Click on File > Save as in the menu bar.
3. Select storage location and enter the file name.
4. Click on [Save].
   - The new parameter file is shown in the file list.

Only the parameters are saved from an instrument file; the history data are not adopted.

The original name (Instrument type, Serial number) is suggested with the current date/time as standard, e.g. "testo 6321 01234578 061120 1403.cfp".

For a standard installation, the files are saved under "C:\Documents and Settings\All Users\Shared Documents\P2A Software". The path can differ depending on the version of the operating system.

5.3.2.4. Opening the parameter file
All parameter files stored in the standard directory path are automatically displayed in the file list when the software is started.

You can also open parameter files that are stored in other directories.

1. Click on File > Open in the menu bar.
2. Select the storage location and click on the requisite file.
3. Click on [Open].
   - The selected file is opened. This can be changed and saved (see Editing instrument/parameter file page 24).
5.3.2.5. **Copying and pasting parameters**

The parameters of a parameter file can be transmitted to an instrument file or another parameter file from the same instrument type.

1. Select file from which parameters are to be copied.
2. Click on **Edit > Copy** in the menu bar.
3. Select the file which is to be modified.
4. Click on **Edit > Paste** in the menu bar.
   - The parameters are transmitted to the file.

> You can also use the common keyboard shortcuts for copying (CTRL+C) and pasting (CTRL+V).

Parameters can also be transmitted using drag & drop, where you drag the icon of the parameter file onto the icon of the target instrument file.

5. Connect and select corresponding instrument.
6. Click on **[Change parameterization]**.
7. Confirm confirmation request.
   - Parameter data are transferred to the instrument.

5.3.2.6. **Deleting instrument/parameter file**

Instrument/parameter files can be deleted from the file list.

1. Click on the file that is to be deleted with the right mouse button.
2. Select the command **Delete** in the context menu.
   - The instrument or parameter file is deleted from the list.

5.3.3. **Analyzing/testing the transmitter**

In this section, you can test the outputs of the connected instrument, read off the limit values and reset the parameters to the factory settings.

The function is only available for instrument files.
5.3.3.1. Analyzing/testing the instrument

✓ The required instrument file is marked.

1. Click on [Test/analyze transmitter].
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2. Perform action:

<table>
<thead>
<tr>
<th>Action</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carry out factory reset</td>
<td>Reset the unit, limit value and hysteresis parameters to factory settings (see below).</td>
</tr>
<tr>
<td>Test analog output</td>
<td>Test channel 1 (see Testing analog output page 28).</td>
</tr>
<tr>
<td>Display min./max. values</td>
<td>Overview of the minimum and maximum values measured since the last reset of the transmitter (see Displaying min./max. values page 30).</td>
</tr>
</tbody>
</table>

3. Click on [OK] or [Cancel] to close the dialogue.

5.3.3.2. Carrying out factory reset

✓ The required instrument file is marked.

1. Click on [Test/analyze transmitter].
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2. Mark transmitter test.
   - Current operating hours are shown.

3. Confirm control query to perform the reset.
   - The values are reset to the customer-specific factory settings.

4. Click on [OK] or [Cancel] to close the dialogue.

5.3.3.3. Testing analog output

✓ The required instrument file is marked.

1. Click on [Test/analyze transmitter].
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Test/analyze transmitter register.

2. Mark channel and test values.
### Field/button | Explanation
--- | ---
Transmitter test | Monitoring of analog outputs

<table>
<thead>
<tr>
<th>Current reading</th>
<th>Readings are updated every second.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit</strong></td>
<td>Unit according to the type of analog output.</td>
</tr>
<tr>
<td><strong>Default value</strong></td>
<td>Freely definable output value for the respective type of analog output (V or mA), 1 decimal place.</td>
</tr>
</tbody>
</table>

#### [Activate]
- The entered defined value is forwarded to the analog output by clicking. The current reading is frozen.
- A warning informs that the value is being transmitted to the connected instrument in the event of existing cabling.
- Now check the analog output using a precise multimeter.

#### [Deactivate]
- Finish entering the electrical variables at the analog output.
- The analog output returns to the current reading again.

3. Click on **[OK]** or **[Cancel]** to close the dialogue.

- The analog output returns to Measuring Mode again.
5.3.3.4. **Displaying min./max. values**

The transmitter saves the minimum or maximum value for each channel (measured since the last voltage supply or since the last manual reset).

✓ The required instrument file is marked.

1. Click on [Test/analyze transmitter].
   - The **Properties of <Instrument type> <Serial number>** dialogue is opened with the Test/analyze transmitter register.

2. Mark **Min./max. values**.

<table>
<thead>
<tr>
<th>Field/button</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min./max. values</td>
<td>View the min./max. values of each channel. Only the values within the measuring range are shown.</td>
</tr>
</tbody>
</table>

![Properties dialogue](image.png)

<table>
<thead>
<tr>
<th>Channel</th>
<th>Channel 1 min./max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Min. or max. value, 1 decimal place.</td>
</tr>
<tr>
<td>Unit</td>
<td>Unit selected in Unit/analog output.</td>
</tr>
</tbody>
</table>

3. Reset **Min./max. values**.
4. Click on [Reset min./max. values].
5. Confirm control query to perform the reset.
   - The values are reset to the factory settings.
5. Click on [OK] or [Cancel] to close the dialogue.

5.3.4. Adjusting the transmitter

This function is used to adjust an attached instrument. The following adjustments may be carried out using the software:

- Analog adjustment (entry via assistant/wizard)
- n-point adjustment (entry via assistant/wizard)

5.3.4.1. n-point adjustment

With an n-point adjustment, the parameters at the 3-6 measurement points are adjusted to the reference value. The reference conditions are obtained by using a precise pressure sensor that should be 5-times more accurate than the transmitter.

✓ A precise pressure sensor (5-times more accurate than the transmitter, e.g. DPC precision pressure sensor from testo industrial services) is available.

1. Connect positive output of the pressure sensor (3) to the positive pressure connection of the transmitter (2) and the negative output of the pressure sensor (3) to the negative pressure connection of the transmitter (1).

4. Connect transmitter to PC via service plug.

5. Mark the instrument file of the connected instrument in the P2A software.

6. Click on [Adjusting the transmitter].

- The Properties of <Instrument type> <Serial number> dialogue is opened with the Adjusting the transmitter register.

7. Mark n-point adjustment.

8. Click on [Start wizard …] and follow the instructions of the wizard.

- The adjustment is performed when the wizard is closed.
5 Parameterizing, adjusting and analyzing software (P2A software)

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>How much pressure is actually applied</td>
<td>Required field: Entry of the value read off at the pressure sensor.</td>
</tr>
</tbody>
</table>

The n-point adjustment must always be carried out to its full extent and in good time at all selected adjustment points.

9. Disconnect connections between the pressure sensor and the pressure connections of the testo 6321.

5.3.4.2. Adjusting the analog output

1. Connect precision multimeter (see Wiring the instrument page 14).

2. Mark the instrument file of the connected instrument.

3. Click on [Adjusting the transmitter].
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Adjusting the transmitter register.

4. Click on [Start wizard …] and follow the instructions of the wizard.
   - The adjustment is performed when the wizard is closed.
### Field Explanation

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default value</td>
<td>The analog output value from the last performed adjustment is given at the output. Value of the factory adjustment:</td>
</tr>
<tr>
<td></td>
<td>• Lower adjustment point: approx. 10 % of the max. value</td>
</tr>
<tr>
<td></td>
<td>• Centre adjustment point: approx. 50 % of the max. value</td>
</tr>
<tr>
<td></td>
<td>• Upper adjustment point: approx. 90 % of the max. value</td>
</tr>
<tr>
<td>Measured analog value</td>
<td>Required field: Entry of the value read off at the multimeter.</td>
</tr>
</tbody>
</table>

#### 5.3.5. Transmitter history

Parameterizations and adjustment processes are registered in the transmitter with an operating hours stamp.

In the history overviews (explained later in more detail), past processes and events can be made visible.

- For entries that are performed using the P2A software, the name of the user logged into Windows appears in the User field, while the date/time and operating hour are shown in the Date/time field.

1. Mark the instrument file of the connected instrument.
2. Click on the [Transmitter history] button.
   - The Properties of <Instrument type> <Serial number> dialogue is opened with the Transmitter history register.

3. Click on the required entry in the list to change the display.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating hours /</td>
<td>Operating hour/time stamp at which the change at</td>
</tr>
<tr>
<td>date/time</td>
<td>the instrument was performed.</td>
</tr>
<tr>
<td>User</td>
<td>Name with which the user is logged into the</td>
</tr>
<tr>
<td></td>
<td>operating system.</td>
</tr>
<tr>
<td>Comments</td>
<td>Type of parameter change, e.g. &quot;Unit of channel</td>
</tr>
<tr>
<td></td>
<td>1 from Pa to hPa&quot;.</td>
</tr>
</tbody>
</table>
Field | Explanation
--- | ---
Selection of adjustment histories: **n-point adjustments / Analog adjustments**.

| Operating hours / date/time | Operating hour/time stamp at which the change at the instrument was performed. |
| User | Name with which the user is logged into the operating system. |
| Channel | Analog adjustment: Channel 1. |
| Multimeter | Analog adjustment: Value read off at reference instrument. |
| Offset | Analog adjustment: Deviation at time of adjustment. |
| Pressure specification | n-point adjustment: Value read off at pressure sensor. |
| Unit | Unit during the adjustment. |

> To print out the history data, click on [Print].

The printing job is automatically sent to the default printer for the operating system.

With [Set up printer ...] a different printer can be selected or the printout can be edited.
4. Click on [OK] or [Cancel] to close the dialogue.

6 Tips and assistance

6.1. Questions and answers

<table>
<thead>
<tr>
<th>Question</th>
<th>Possible causes/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection to instrument cannot be established</td>
<td>Check connection cable/plug contacts</td>
</tr>
<tr>
<td>Malfunction (with and without display)</td>
<td>Analysis using the P2A software, see Analyzing/testing the transmitter page 27</td>
</tr>
<tr>
<td>Adjustment is to be reversed</td>
<td>Carry out factory reset (Test/analyze transmitter).</td>
</tr>
<tr>
<td>When does a stable current reading appear?</td>
<td>After approx. 20 seconds</td>
</tr>
</tbody>
</table>

If we could not answer your question, please contact your dealer or Testo Customer Service. For contact details see the rear side of this document or the web page www.testo.com/service-contact

6.2. Accessories and spare parts

<table>
<thead>
<tr>
<th>Description</th>
<th>Article no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface and software</td>
<td></td>
</tr>
<tr>
<td>P2A software (parameterizing, adjusting, analyzing) incl. USB adapter</td>
<td>0554 6020</td>
</tr>
<tr>
<td>Supply</td>
<td></td>
</tr>
<tr>
<td>Mains unit (desktop, wall-mounted)</td>
<td>0554 1748</td>
</tr>
<tr>
<td>Mains unit (top-hat rail mounting)</td>
<td>0554 1749</td>
</tr>
<tr>
<td>Hose</td>
<td></td>
</tr>
<tr>
<td>Silicone hose ID 4 transparent</td>
<td>0086 0001, sold by the metre</td>
</tr>
<tr>
<td>TYGON hose ID 4.8 transparent</td>
<td>0086 0031, sold by the metre</td>
</tr>
<tr>
<td>Calibration</td>
<td></td>
</tr>
<tr>
<td>Standard ISO calibration certificate, transmitter only</td>
<td>0520 1000</td>
</tr>
</tbody>
</table>
### 6.2.1. Ordering options for testo 6321 transmitter (0555 6321)

<table>
<thead>
<tr>
<th>Order code</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axx</td>
<td>Measuring range</td>
</tr>
<tr>
<td>A03</td>
<td>0 to 100 Pa</td>
</tr>
<tr>
<td>A05</td>
<td>0 to 10 hPa</td>
</tr>
<tr>
<td>A06</td>
<td>0 to 20 hPa</td>
</tr>
<tr>
<td>A07</td>
<td>0 to 50 hPa</td>
</tr>
<tr>
<td>A08</td>
<td>0 to 100 hPa</td>
</tr>
<tr>
<td>A09</td>
<td>0 to 500 hPa</td>
</tr>
<tr>
<td>A10</td>
<td>0 to 1000 hPa</td>
</tr>
<tr>
<td>A11</td>
<td>0 to 2000 hPa</td>
</tr>
<tr>
<td>A23</td>
<td>-100 to 100 Pa</td>
</tr>
<tr>
<td>A25</td>
<td>-10 to 10 hPa</td>
</tr>
<tr>
<td>A26</td>
<td>-20 to 20 hPa</td>
</tr>
<tr>
<td>A27</td>
<td>-50 to 50 hPa</td>
</tr>
<tr>
<td>A28</td>
<td>-100 to 100 hPa</td>
</tr>
<tr>
<td>A29</td>
<td>-500 to 500 hPa</td>
</tr>
<tr>
<td>A30</td>
<td>-1000 to 1000 hPa</td>
</tr>
<tr>
<td>A31</td>
<td>-2000 to 2000 hPa</td>
</tr>
<tr>
<td>Bxx</td>
<td>Analog output/supply</td>
</tr>
<tr>
<td>B02</td>
<td>0 to 1 V (4-wire, 24 V AC/DC)</td>
</tr>
<tr>
<td>B03</td>
<td>0 to 5 V (4-wire, 24 V AC/DC)</td>
</tr>
<tr>
<td>B04</td>
<td>0 to 10 V (4-wire, 24 V AC/DC)</td>
</tr>
<tr>
<td>B06</td>
<td>4 to 20 mA (4-wire, 24 V AC/DC)</td>
</tr>
<tr>
<td>Order code</td>
<td>Characteristic</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td><strong>Cxx Display</strong></td>
<td></td>
</tr>
<tr>
<td>C00</td>
<td>Without display</td>
</tr>
<tr>
<td>C01</td>
<td>With display</td>
</tr>
<tr>
<td><strong>Exx Housing colour and logo</strong></td>
<td></td>
</tr>
<tr>
<td>E01</td>
<td>Grey housing, testo logo in colour</td>
</tr>
<tr>
<td>E02</td>
<td>White housing, without testo logo</td>
</tr>
<tr>
<td>E03</td>
<td>White housing, black-and-white testo logo</td>
</tr>
<tr>
<td><strong>Fxx Differential pressure unit</strong></td>
<td></td>
</tr>
<tr>
<td>F01</td>
<td>Pa/Min/Max</td>
</tr>
<tr>
<td>F02</td>
<td>hPa/Min/Max</td>
</tr>
<tr>
<td>F03</td>
<td>kPa/Min/Max</td>
</tr>
<tr>
<td>F04</td>
<td>mbar/Min/Max</td>
</tr>
<tr>
<td>F05</td>
<td>bar/Min/Max</td>
</tr>
<tr>
<td>F06</td>
<td>mm H₂O /Min/Max</td>
</tr>
<tr>
<td>F07</td>
<td>inch H₂O /Min/Max</td>
</tr>
<tr>
<td>F08</td>
<td>inch HG /Min/Max</td>
</tr>
<tr>
<td>F09</td>
<td>kg/cm² /Min/Max</td>
</tr>
<tr>
<td>F10</td>
<td>PSI/Min/Max</td>
</tr>
<tr>
<td><strong>Kxx Languages of instruction manual</strong></td>
<td></td>
</tr>
<tr>
<td>K01</td>
<td>German/English instruction manual</td>
</tr>
<tr>
<td>K02</td>
<td>French/English instruction manual</td>
</tr>
<tr>
<td>K03</td>
<td>Spanish/English instruction manual</td>
</tr>
<tr>
<td>K04</td>
<td>Italian/English instruction manual</td>
</tr>
<tr>
<td>K05</td>
<td>Dutch/English instruction manual</td>
</tr>
<tr>
<td>K06</td>
<td>Japanese/English instruction manual</td>
</tr>
<tr>
<td>K07</td>
<td>Chinese/English instruction manual</td>
</tr>
</tbody>
</table>